Alma January 2021 Release

Our Changing World, Our Changing Libraries
Saluting Medical Personnel around the World

Alma January 2021 Release Notes
CONFIDENTIAL INFORMATION

The information herein is the property of Ex Libris Ltd. or its affiliates and any misuse or abuse will result in economic loss. DO NOT COPY UNLESS YOU HAVE BEEN GIVEN SPECIFIC WRITTEN AUTHORIZATION FROM EX LIBRIS LTD.

This document is provided for limited and restricted purposes in accordance with a binding contract with Ex Libris Ltd. or an affiliate. The information herein includes trade secrets and is confidential.

DISCLAIMER

The information in this document will be subject to periodic change and updating. Please confirm that you have the most current documentation. There are no warranties of any kind, express or implied, provided in this documentation, other than those expressly agreed upon in the applicable Ex Libris contract. This information is provided AS IS. Unless otherwise agreed, Ex Libris shall not be liable for any damages for use of this document, including, without limitation, consequential, punitive, indirect or direct damages.

Any references in this document to third-party material (including third-party Web sites) are provided for convenience only and do not in any manner serve as an endorsement of that third-party material or those Web sites. The third-party materials are not part of the materials for this Ex Libris product and Ex Libris has no liability for such materials.

TRADEMARKS

Ex Libris, the Ex Libris logo, Alma, campusM, Esploro, Leganto, Primo, Rosetta, Summon, ALEPH 500, SFX, SFXIT, MetaLib, MetaSearch, MetaIndex and other Ex Libris products and services referenced herein are trademarks of Ex Libris, and may be registered in certain jurisdictions.

The absence of a name or logo in this list does not constitute a waiver of any and all intellectual property rights that Ex Libris Ltd. or its affiliates have established in any of its products, features, or service names or logos.

Trademarks of various third-party products, which may include the following, are referenced in this documentation. Ex Libris does not claim any rights in these trademarks. Use of these marks does not imply endorsement by Ex Libris of these third-party products, or endorsement by these third parties of Ex Libris products.

Oracle is a registered trademark of Oracle Corporation.

UNIX is a registered trademark in the United States and other countries, licensed exclusively through X/Open Company Ltd.

Microsoft, the Microsoft logo, MS, MS-DOS, Microsoft PowerPoint, Visual Basic, Visual C++, Win32,

Microsoft Windows, the Windows logo, Microsoft Notepad, Microsoft Windows Explorer, Microsoft Internet Explorer, and Windows NT are registered trademarks and ActiveX is a trademark of the Microsoft Corporation in the United States and/or other countries.

Unicode and the Unicode logo are registered trademarks of Unicode, Inc.

Google is a registered trademark of Google Inc.

iPhone is a registered trademark of Apple Inc.
Make the Most of January's Release

<table>
<thead>
<tr>
<th>Action Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receiving Digital Files for Borrowing Resource Sharing Requests - Two new options are included in this release for libraries that receive or ship digital files for fulfilling resource sharing requests:</td>
</tr>
<tr>
<td>1. If you have received an attachment as a borrower, you can upload it to the borrowing requests task list and have Alma send an email with a link to the patron</td>
</tr>
<tr>
<td>2. When both the borrower and lender are Alma institutions, the lender can trigger the borrower side to send an email directly to requesting patron, without requiring that the borrower exposes the patron’s email to the lender.</td>
</tr>
<tr>
<td>Allow automation of branch requesting for RS serial requests - As resource sharing lenders, you can have Alma automatically create pickup request at branch libraries (for physical and for digital supply). When the requested resource is a serial or multi volume, you can now have Alma create a general hold/digitization request. This is in addition to the previously only option to automatically create a title level request. This would enable an automated branch requesting process for libraries that have cataloged their serial issues.</td>
</tr>
<tr>
<td>Retry Rapid Requests - If you are using Rapid ILL in an integrated manner, you can now override Rapid self ownership blocks using a dedicated &quot;Override local holding&quot; action in the Alma task list.</td>
</tr>
<tr>
<td>Improved Inventory Import - As part of the import profile, you can now define how to map the imported records to existing records in Alma.</td>
</tr>
<tr>
<td>Additional Recent Entities Added - This release adds three key configuration entities (Code table, mapping table and integration profiles) to the Recent Entities slide out, enabling you to easily view recent changes made by you, and in a single click, navigate back to the specific table or profile you modified.</td>
</tr>
</tbody>
</table>

Upcoming Issues to Note

Sandbox Refresh

As a reminder, premium sandboxes will be updated in February according to Alma's premium sandbox refresh policy.

Analytics Infrastructure Performance Upgrades

Ex Libris is currently implementing performance upgrades to the Alma Analytics infrastructure which will include the Oracle In-Memory Database. These upgrades will greatly improve performance when running analytics reports and are being rolled out gradually. The table below describes the rollout plan. For more information, see the Analytics - Infrastructure Improvements in 2020 document.
<table>
<thead>
<tr>
<th>Instance</th>
<th>Will be implemented during</th>
</tr>
</thead>
<tbody>
<tr>
<td>NA01</td>
<td>Completed</td>
</tr>
<tr>
<td>NA02</td>
<td>Completed</td>
</tr>
<tr>
<td>NA03</td>
<td>Completed</td>
</tr>
<tr>
<td>NA04</td>
<td>Completed</td>
</tr>
<tr>
<td>NA05</td>
<td>Completed</td>
</tr>
<tr>
<td>NA06</td>
<td>Completed</td>
</tr>
<tr>
<td>NA07</td>
<td>Completed</td>
</tr>
<tr>
<td>NA91</td>
<td>Completed</td>
</tr>
<tr>
<td>EU00</td>
<td>Completed</td>
</tr>
<tr>
<td>EU01</td>
<td>Completed</td>
</tr>
<tr>
<td>EU02</td>
<td>Completed</td>
</tr>
<tr>
<td>EU03</td>
<td>Completed</td>
</tr>
<tr>
<td>EU04</td>
<td>Completed</td>
</tr>
<tr>
<td>AP01</td>
<td>Completed</td>
</tr>
<tr>
<td>CA01</td>
<td>Completed</td>
</tr>
<tr>
<td>CN01</td>
<td>January 2021</td>
</tr>
</tbody>
</table>
Alma Roadmap Highlights

The next version of the Alma Roadmap Highlights document will be published in January 2021.

Next Release Sneak Preview

Select February 2020 Sneak Preview to view the next release sneak preview.
Alma January 2021 Main Stories

PO Line Infrastructure Upgrade

January 2021 Acquisitions

In the upcoming releases, there will be technical upgrades to the PO line infrastructure but will not result in any functional changes.

PO Line confirmation messages to include the owning library

January 2021 Acquisitions

In Alma, the existing pop-up message for the "Create PO Line" workflow was enhanced to notify users to which library the existing PO line is associated and with which library the existing item is associated with (when creating a physical PO line).

Additionally, these 2 alerts was added to the 'Manage Acquisitions alert' configuration screen (Configuration Menu -> Acquisitions > Manage acquisitions alerts) so that institutions can set it not to appear:

Control Availability Status of Electronic Resources created via Real Time Ordering

January 2021 Acquisitions

A new customer parameter (acq_activate_portfolio_from_API) was added to enable institutions to decide if electronic resource orders created via Real Time Ordering will create the Community Zone (CZ) linked portfolio as 'available' or as 'not-available'.
In case the parameter is set to 'true', institutions are no longer required to go via the E-Activation task list in order to make the resource available as it is created as such when the order enters into Alma.

The Out of the Box (OTB) value for this parameter is set to "False" and will create the e-resource via the Real Time order process as "Not Available" to modify the parameter go to Configuration menu -> Acquisitions -> Other settings -> acq_activate_portfolio_from_API (set this to 'true' for portfolios to be created as 'Available').

---

**Additional collections for activating OASIS 'Real Time' Ordered Portfolios from the Community Zone**

**January 2021 Acquisitions**

Five new collections were added to the 'Real time Order' workflow of activation of Community Zone resources for orders originating from OASIS.

The collections are:

<table>
<thead>
<tr>
<th>Provider Name</th>
<th>Collection Name</th>
<th>Collection ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brill Online</td>
<td>Brill Online Books</td>
<td>613170000000000148</td>
</tr>
<tr>
<td>De Gruyter</td>
<td>De Gruyter eBooks Complete</td>
<td>611000000000002268</td>
</tr>
<tr>
<td>IGI Global Online</td>
<td>IGI Global InfoSci-Books</td>
<td>611000000000002255</td>
</tr>
<tr>
<td>JSTOR</td>
<td>JSTOR Books</td>
<td>61317000000000272</td>
</tr>
<tr>
<td>Oxford Scholarly Editions Online</td>
<td>Oxford Scholarly Editions Online</td>
<td>61384000000000106</td>
</tr>
<tr>
<td>Project MUSE</td>
<td>Project MUSE - EBA All Single Title Collection</td>
<td>61491000000001606</td>
</tr>
</tbody>
</table>

See OASIS vendors list for full list of Community Zone collections which supports this functionality.

---

**Email Notification from CDI Publishing Profile**

**January 2021 Resource Management**

The Alma Publish Electronic Records to Central Discovery Index job now has an Email Notification button for users to opt in to automated emails updated when publishing runs.

---

**New Holdings Management Privilege**

**January 2021 Resource Management**

A new privilege PHYSICAL_INVENTORY_MANAGE was added to ensure that unauthorized users cannot change existing holdings. Users with CATALOGING privileges only are no longer able to create and edit holdings. Only users with the privilege PHYSICAL_INVENTORY_MANAGE can create and edit holdings by scope.
To make sure that holdings management is only done by authorized users, the following changes were made to Alma roles:

- New privilege PHYSICAL_INVENTORY_MANAGE is now part of the following roles:
  - PHYSICAL_INVENTORY_OPERATOR
  - PHYSICAL_INVENTORY_OPERATOR_LIMITED
  - PURCHASE_MANAGER
  - PURCHASE_OPERATOR
  - REPOSITORY_MANAGER
- Users with PHYSICAL_INVENTORY_DELETE role can delete a holdings record.
- Users with CATALOGING privileges only will no longer be able to manage holdings. They will need to be given a role that has the PHYSICAL_INVENTORY_MANAGE/DELETE privilege.

See Metadata Editor and Navigating the MD Editor Page.

New Metadata Editor

Enhancements to the New Metadata Editor Layout

January 2021 Resource Management

The following changes were made:

- The three functional areas of the MDEditor - Records, Templates and Rules - are now located on the Navigation pane as tabs, and not as a dropdown, for better visibility and quicker access.
- Under each functional area, the tabs of the new MDEditor are now located in the Navigation pane. This frees valuable real estate on the MDEditor that can be used for cataloging work. The new compact design allows quick access for users who work with few record types, while still providing full access for users who work with many record types. Each tab represents a different type of records (Sets, DC, MARC21, UMIMARC and the other formats, Holdings, Authorities formats). To open records of a certain record family, click the tab. The tab changes its color to blue (see Holdings in the screenshot below) to indicate that its records are currently displayed in the Navigation pane. To view other record types, select the arrow, and select the desired type of records from the list.
Ex Libris continues the rollout of the new Metadata Editor. In the current release, the Template Management core functionality was introduced (the functionality available in the original Metadata Editor plus new features). Rule management will be rolled out in the upcoming releases (see Rollout Plan), giving users enough time to adjust to the changes.

Alma users can switch back and forth between the Records and Templates areas in new and the original Metadata Editors.

To switch:

- to the new Metadata Editor, select

  ![New MDE](image)

  on the left-hand side of the top toolbar of the Editor.

- back to the original Metadata Editor, select

  ![Old Editor](image)

  on the left-hand side of the top toolbar of the Editor.

**Note**

Ex Libris recommends that all relevant users start familiarizing themselves with the new Metadata Editor prior to its Go-Live, which is planned to take place with the deployment of January 2021 release.
See New Metadata Editor Functionality.

Watch the Manage Record Templates video (2:26 minutes).

**Side-by-side Editing of Primary and Searched/Browsed Records**

**January 2021 Resource Management**

Now you can view the searched/browsed record alongside your primary bibliographic record. This allows you to compare your bibliographic record with the searched record, while also providing easy navigation back to the search form to refine your search, if needed.

When you have a bibliographic record open in the MDEditor, and you trigger **Search External Resources**, the search form opens in the right pane. Search Results cover the search panel with the option **Back to Results** that allows you to go back to refine your search. When selecting **View** on one of the results, the viewed record now covers the left pane, with an option to go back to results. The bibliographic record that you had open in the right pane appears again, allowing you to compare both.

![Side-by-side Editing of Primary and Searched/Browsed Records](image)

See Working with Search Resources in the MD Editor.

---

**Improved Inventory Import**

**January 2021 Resource Management**

As part of the import profile, you can define how to map the imported records to existing records in Alma (if there are such). This is done on the **Inventory Information** tab of the Import Profile page (Resources > Import > Manage Import Profiles or Acquisitions > Import > Manage Import Profiles).

The following changes were made to the **Inventory Information** tab:

- For physical inventory, you can now map the inventory information in the input file either from a single field or from different fields.
- The tab was redesigned to display information clearer.

See Managing Import Profiles.

---

**Search Index Operators for Local Call Numbers**

**January 2021 Resource Management**

Search operators were added to the local call numbers index.
Community Zone Updates - Remove Bibliographic Records With No Inventory

January 2021 Resource Management

Up till now, when a Community Zone portfolio was updated to relink to a different bibliographic record, the Community Zone Update process updated the Institution Zone portfolio to point to the new bibliographic record, but the old bibliographic record remained in the Institution Zone even if it no longer had inventory. Starting from this release, if the bibliographic record does not have any inventory, the Community Zone Update process removes it.

Community Zone Task now includes a dedicated report type for this type of Community Zone updates, "Portfolio bibliographic record updated". This report type shows the MMS ID of the deleted bibliographic record and MMS ID of the new bibliographic record to which the portfolio was relinked.

See Working with the Community Zone Updates Task List.

New Alma Hot Keys

January 2021 Resource Management

The following hot keys were added to Alma to allow you to work faster.

- **Ctrl+Alt+C** - Press to toggle the Configuration menu open/closed, without closing the page that is currently at work.

See Global Alma Hot Keys.

Collection of Type ‘Search Rights in CDI: Subscription’ Require Activation

January 2021 Resource Management

Collections that are defined as ‘Search Rights in CDI: Subscription’ can only be activated for search in CDI if your institution subscribes to the collection.

As of this release CDI Fully Flexible customers can indicate that they have subscription for these type of collections by activating the collections in Alma or by setting them up as 'Full text in CDI Only'; it will no longer be possible to 'Activate for Search in CDI'

e:example:
Enhancements to Digital Copyright Statements

December 2020 Digital Resource Management

Several enhancements were implemented for configuring Digital Copyright statements:

- Digital copyright statements were separated from the general copyright declarations and now has its own page: Copyright Statements - Digital.
- The out-of-the-box set of boilerplate copyright statements now includes all Creative Commons licenses, Rightsstatements, and US Code. These statements are view-only and are available in the Boilerplate section of the page.
- A new Custom section is available on the Copyright Statements - Digital page where you can add an unlimited number of custom made copyright statements.

For more information, see Configuring Copyright Statements – Digital.

New circulation desk configuration to control the appearance of the 'Override return Date and Time' field in the 'Return Items' page

January 2021 Fulfillment

Institutions now have the ability to configure that the circulation desk does not display the Override return date and time field in the 'Return Items' page. Previously, this field was displayed at all times and scenarios for user roles where this was enabled, because the field was not associated to any circulation desk configuration. Institutions now have control and can limit the appearance of the field.
To set this configuration, go to the relevant location in the 'Configuring' dropdown menu on the top of the configuration menu then go to Fulfillment->Circulation Desks-> Add/Edit the relevant desk and see the 'Supports overriding return date' field (enabled by default):

Watch the Turn Off the Option to Override Return Date at a Circulation Desk video (1:11 minutes).

Automated Resource Sharing Request Digitization Process

January 2021 Fulfillment-Resource Sharing

Alma now allows the resource sharing request digitization process to be automatic even when there are multiple branch library level digitization departments. Previously, the process of creating a request could work if there was only one digitization department at the institution. If there were branch library digitization departments then the digitization requests needed to be created manually by the resource sharing staff and manually assigned to the relevant branch library.

To enable this functionality go to the Configuration menu->Fulfillment->General->Other settings, customize the 'rs_default_digitization_department' parameter and set its value to 'prefer_local':

The new configuration is currently not supported for AFN requests. If your consortium is working with AFN, a specific digitization department needs to be used.

Alma to Alma - Send digitized content directly to patron

January 2021 Fulfillment-Resource Sharing

In Alma ISO resource sharing, digitized content provided as a link by the lender can now be sent to patrons without the email address of the patron being shared with the lender. The shipped digitally message from the lender triggers the borrower side to send an email to the patron with a link that requires authentication on the borrower side, which then directs the patron to the document the lender uploaded. Before, this process required sharing the patron email with the lender by setting the partner to support ADD address, which raised a privacy concern for libraries. The email with the link to the digitized content is now sent regardless of the ADD address configuration. The customer parameter borrower_document_delivery_send_automatically (on the borrower side) determines whether the document delivery email is sent automatically to the patron when resource is shipped by the lender, or will be sent manually by the librarian on the borrower side using new 'View File' and 'Send File to Patron' row actions in the borrowing request task list.
Send digitized content to patron - Upload file

January 2021 Fulfillment-Resource Sharing

Idea Exchange

Library staff is now able to upload a file to a borrowing resource sharing request in Alma and have Alma send the document delivery email with a controlled link to the file. When a non-Alma library sends a digital file to an Alma library the file has to be sent as an attachment to an email. Before, forwarding this email to the patron had to be done using tools outside of Alma. Librarians can now use Alma to send patrons uniformed emails and not different emails depending on how the file was obtained, using new 'Upload File' and 'Send File to Patron' row actions in the borrowing request task list.

Retry Rapid request

January 2021 Fulfillment-Resource Sharing

In Alma, when a borrowing request is sent to Rapid using the API, the operator is now notified by Alma that Rapid found a local match for the request. The operator is then given an option to override this and send the request to Rapid anyway. If the request is sent to Rapid and rejected because of a local match then the request is assigned the new 'Local Holding' status. This allows to easily identify automatic send attempts to Rapid that were rejected because of local holdings. The new "Override local holding" action allows to override the Rapid rejection.

Allow automation of branch requesting for RS serial requests

January 2021 Fulfillment-Resource Sharing

The process for automatically creating an internal ship physically/digitally request for a serial/multi volume resource was enhanced. Before, when the lending request was for a serial/multi volume resource, Alma supported either mediating the request or have a title level request created automatically. A new option was added which will automatically create requests with a manual description containing the relevant metadata from the lending request (if exists), providing the librarian picking the item from the shelf with information to help select the required volume/issue.

This can be done by setting the values of the \texttt{rs\_auto\_request\_lending\_with\_serials} and \texttt{rs\_auto\_request\_lending\_with\_volume\_issue} parameters to 'general'.

New Alma Layout - Hurry to Opt In for a Better Working Experience

January 2021 Resource Management

The rollout of the new Alma layout continues, and the new layout is already the default for thousands of Alma users.

Note

Ex Libris recommends that all users opt-in to gain experience with the new layout. Starting from March 2021, it will no longer be possible to use the old layout.

The new layout increases your working area, improves navigation, gives you more options to customize your menus, and facilitates improved user workflows. For a full list of changes and opt-in instructions, see Layout Improvements.
Consortia CDI Inheritance

January 2021 Collaborative Networks

The CDI inheritance indication has been added to the Network tab making it visible and easy to understand whether the institution inherits the collection CDI setup from the Network Zone (NZ) or not. CDI inherited collections will be presented in the combined search results and the Network Zone tab with the specific CDI related setup present in a new dedicated CDI drawer.

The example above shows that the collection ‘Scholars Portal Books: Springer-Religion and Philosophy 2017’ was activated in Alma for 'Alma Academy' but the Network decided not to mark its content as Full Text Available in CDI.

The CDI drawer will indicate the following information (when relevant):

- **Available for**: Contains the Alma full text activation.
- **Do not show as full text in CDI even if active in Alma**: Lists all member institutions / campuses for which 'Do not show as full text in CDI even if active in Alma' is selected.
- **CDI only full text activation**: Lists all member institutions / campuses with FT in CDI only activation.
- **CDI search activation**: Lists all member institutions / campuses with CDI search activation.

**Note**

The CDI drawer will also be displayed for institutions with distributed management of electronic resources. In this case, it will present the CDI setup for the relevant “Available For Groups”.

Re-assign MMS Records in Network Shared Catalog

January 2021 Collaborative Networks

The Assign Record to Another Cataloger action in the Metadata Editor now provides the ability to assign Bibliographic and Authority Network Zone records to a cataloger from another institution within the network.
Note
This functionality is available only in the new Metadata Editor.

The new functionality is available only when the new customer parameter `enable_nz_record_assignment` in NZ environment is set to True ([Configuration Menu > Resources > General > Other Settings](#)). This parameter is available only for the Network Zone, since the network sets this policy for all its member. Stand-alone institutions and NZ members do not have access to this parameter.

See Assigning a Network Zone Cataloging Record to a Cataloger of Another Institution, Contributing to the Community Zone – Bibliographic Records and Configuring Other Settings (Resource Management).

Watch the Assign Record to a Cataloger in Another Institution of the Network video (1:31 minutes).

---

**New Alma Analytics Dashboard for Analytics Objects**

**January 2021 Analytics**

A new Alma Analytics dashboard is now available for the Analytics Objects subject area. It contains the following reports that display information concerning the Analytics Objects of your institution:

- Customized objects with at least one user
- Customized objects with no users
- Number of objects created per user
- Objects breakdown by type
- Objects created in the last year (last 365 days)
- Top 5 most popular scheduled reports and widgets

For more information, see Out-of-the-Box Reports.

---

**Configuration Change Tracking in Code and Mapping Tables**

**January 2021 Administration and Infrastructure**

Now you can see the history of changes made by your staff to code and mapping tables (but not the full details of the change). This helps you know what configuration changes were made, and by whom, for audit purposes.

The decision whether to store these events, and the period during which they are kept, is controlled by the institution. The customer parameter `code_and_mapping_table_log_retention_period` ([Configuration Menu > Resources > Other Parameters](#)) controls the duration of days for which this data is stored. The default is 0 (data is not stored), and you can change it to any number of days.

When the parameter value is higher than 0, Alma now supports storing events when changes are made to the Code or mapping tables. Events include the user that made the change, the table where the change was made, and the action (new row, row update, row deletion). You can then run a report of these events via Alma Analytics.

See Configuring Other Settings.
Support for Authentication Forcing in OpenID Authentication

January 2021 Administration and Infrastructure

Now the OIDC (OpenID Connect) authentication of Alma supports authentication forcing when Alma authenticates users via OIDC. If you want to force authentication when Alma authenticates users via OIDC, select the "Force Authentication" checkbox in the Actions tab of the OpenID Connect integration profile.

![OpenID Connect](image)

See [OpenID Connect](#).

Additional Recent Entities Added

January 2021 Administration and Infrastructure

Actions performed on the following pages are now listed on the Recent Entities pane:

- Mapping tables
- Code tables
- Integration Profiles

![Recent Entities](image)

This provides quick access to the entities you updated recently, without having to go through the entire list of tables or integration profiles. For more information, see [Recent Entities List](#).

Set related APIs have been enhanced to include retrieve (GET) and creation of itemized sets (POST) for vendors

January 2021 API

In Alma, it is now possible to manage itemized sets of vendors via the API.
The Items API was enhanced to include a new option for Sorting by Expected Receive Date

January 2021 API

The Get-Items API now supports sorting by the expected received date. When working with continuous orders and prediction patterns, this enables fetching the items that should be received next and helps to identify items that should be claimed.
Alma January 2021 Additional Enhancements

• **January 2021 Acquisitions**
  The summary section in the ‘Fund and Ledger’ screen was moved to be positioned at the top of the page.

• **January 2021 Digital Resource Management**
  The *Share focused file* checkbox that allows you to share a URL with the viewer focused to a specific file is displayed only when there are multiple files in the representation.

• **January 2021 Digital Resource Management**
  In the new Alma Viewer, you can now collapse the Descriptive Information pane for a larger file display in the center pane.

• **January 2021 Analytics**
  The *Label* and *Label History* (deleted labels) fields were added to Borrowing Requests > Borrowing Request Details and Lending Request > Lending Request Details.

  **Note**

  These fields are relevant for customers with Rapido.

• **January 2021 Analytics**
  The *Duplicate Titles by 035a for network institution* out-of-the-box report was added to the `/shared/Alma/Consortia/Reports` folder. It retrieves duplicate titles by field 035 subfield a in a Network Zone institution and excludes titles linked to the Community Zone. This report is designed to be run in the Network Zone.

• **January 2021 Analytics**
  The new YoY (Year over Year) out-of-the-box dashboard was added to Alma Analytics. It contains the following reports that display changes to data in one period from one year to the next.
  ◦ API executions YoY
  ◦ COUNTER usage Books R4 YoY
  ◦ COUNTER usage Books R5 YoY
  ◦ COUNTER usage Journals R4 YoY
  ◦ COUNTER usage Journals R5 YoY
  ◦ Expenditure for Electronic Format
  ◦ Expenditure for Physical Format
  ◦ Leganto Student Usage Events YoY
  ◦ Loans YoY
  ◦ Patron Physical Item Requests YoY

• **January 2021 Analytics**
  The Proquest Purchase Model field was added to E-Inventory > Portfolio. It contains information for both single institutions and multi-institution implementations. Possible values are:
  ◦ Subscription
  ◦ DDA
  ◦ Owned

---

Ex Libris, a ProQuest Company
• **January 2021 Analytics**

The following fields were added to Usage Data > Usage Data Details - Release 5 to display information for IR R5 COUNTER reports:

- IR - Total Item Requests
- IR - Unique Item Requests
- IR - Total Item Investigations
- IR - Unique Item Investigations
- IR - No License
- IR - Limit Exceeded
- IR_A1 - Unique Item Requests
- IR_A1 - Total Item Requests
- IR_M1 - Total Item Requests
Alma January 2021 Resolved Issues

- **January 2021 Acquisitions** SF: 00843700
  When two interested users for a POL; one that has 'notify upon cancellation' and the other does not have this ticked, both users got the 'InterestedIn letter' after the cancellation of a POL. Now, only users with 'notify upon cancellation' get the letter upon cancellation. &nbsp;

- **January 2021 Acquisitions** SF: 00871456 00751354
  When opening an unassigned tab of a purchase request, an error was displayed. This was fixed.

- **January 2021 Acquisitions** SF: 00849674
  The Approved Format field in the Subject Area of Purchase Request was not populated when the purchase request was approved. This was fixed.

- **January 2021 Acquisitions** SF: 00868116 00865167 00878278 00858821
  The Public Access Model field in ViewIt was not showing translations for languages other than English. This was fixed.

- **January 2021 Acquisitions** SF: 00870518 00743020
  If more than one interested users were in the PO Line, the cancellation letter was sent multiple times (the number of emails per user was the number of the interested users). This was fixed,

- **January 2021 Acquisitions** SF: 00788013
  This issue is resolved by the move to SOLR. SOLR search will be turned on to ALL customers in January 2021 release.

- **January 2021 Acquisitions** SF: 00890369
  A 'Receiving note' was allowed to be added to an electronic PO Line via API. This enabled electronic resources to have 'Receiving notes' that cannot be seen or removed from Alma UI. This was fixed and the 'Receiving note’ will only be added to Physical PO lines.

- **January 2021 Acquisitions** SF: 00890295 00876774 00886289
  When relink holdings for a bib with POL, sometimes POL loses the bib description and becomes 'Missing Description'. This was fixed.

- **January 2021 Acquisitions** SF: 00665548
  The ERP export using the Profile Invoice Payment job was taking too long to run. This was fixed.

- **January 2021 Acquisitions** SF: 00668443 00733177 00668423
  Selecting 'Use prorata' makes Additional Charge invoice lines (99991 - 99994) disappear but their transactions remain when editing an existing invoice with Fund and Transaction. This was fixed and now when saving this change, the transactions are deleted.

- **January 2021 Acquisitions** SF: 00729119
  When details of a license negotiation is set for a year that has more than 365 days (e.g. such as a leap year where there is 29 days in February), the license is considered as multi year by mistake and so the 'Price per year’ is visible instead of Price. This was fixed.

- **January 2021 Acquisitions** SF: 00583614 00887108 00569199 00692954 00609840 00578402 00708071
  In Electronic Activation task list when the user is in the tab ‘Assigned to Others’ and sorts the list by assigned to when navigating to the 'Unassigned' tab, an error message is displayed. This was fixed.

- **January 2021 Acquisitions** SF: 00898267
  Clicking 'Done' in an electronic activation task for PO Lines with Interested users caused an error. This was fixed.

- **January 2021 Administration and Infrastructure** SF: 00858858
  When exporting a Fines and Fees Report, the exported file was generated in *.xls format and not *.xlsx. This has been fixed so that when the parameter 'export_xlsx_fines_fees_report' is enabled, the generated report file will be in *.xlsx format. When the parameter is disabled, *.xls format is generated.

- **January 2021 Administration and Infrastructure** SF: 00809874
  Using the 'Forgot password - reset by email' flow did not work when there were two users in Alma with the same email address, even if one of the users was deleted. This was fixed.

- **January 2021 Administration and Infrastructure** SF: 00882824
User Management Profile includes API roles that are irrelevant. These are now removed.

- **January 2021 Administration and Infrastructure SF: 00805971 00711764 00791173**
  Error in 'Change Vendor in Order' job. This was fixed.

- **January 2021 Administration and Infrastructure SF: 00850785**
  When printing multiple slips from the Lending Resource Sharing Task List, only one slip printed. This was fixed.

- **January 2021 Administration and Infrastructure SF: 00893768**
  New Alma viewer using SAML patron authentication was not working as expected: user name was not displayed after login. This was fixed.

- **January 2021 Administration and Infrastructure SF: 00876486**
  Redundant 'Assign To' letter was removed.

- **January 2021 Administration and Infrastructure SF: 00895541**
  New Alma Layout: In non-English user interface, the 'Chat with Support' box was cut at the bottom. This was fixed.

- **January 2021 Administration and Infrastructure SF: 00632715**
  The Summary panel information popup got cut off sometimes. This was fixed.

- **January 2021 Administration and Infrastructure SF: 00878215 00872145 00872081 00866925**
  New Alma UI: 'Last updated from Community Zone' was missing from the Help menu. This was fixed.

- **January 2021 Administration and Infrastructure SF: 00879056**
  New MDEditor: new MDE was stuck in half screen mode. This was fixed.

- **January 2021 Administration and Infrastructure SF: 00891717**
  When adding subscribers to an Analytics report, you could add a user from pickup only once. In the next times, the search was not closed after selection. This was fixed.

- **January 2021 Administration and Infrastructure SF: 00894240**
  Summary panel information popup cut off in Loan Audit Trail. This was fixed.

- **January 2021 Administration and Infrastructure SF: 00888153 00888161**
  New Alma layout: using the web browser's Back button led to not would inadvertent execution of an operation again. This was fixed.

- **January 2021 Administration and Infrastructure SF: 00875954**
  In the New Layout, printers were sometimes forgotten after logging out and then logging back in. This was fixed.

- **January 2021 Administration and Infrastructure SF: 00902118**
  New Alma layout: Missing advanced search option in Manage Patron Services menu. This was fixed.

- **January 2021 Administration and Infrastructure SF: 00899195**
  In Alma Viewer, quick access mode, the video was too big and the control buttons were hidden. This was fixed.

- **January 2021 Administration and Infrastructure SF: 00867767**
  The Link to Primo Studio for configuring Deposit UI didn’t include 'Create Deposit' button. This was fixed.

- **January 2021 Analytics SF: 00860255 00880771 00861463 00862902 00871324 00859068 00869974**
  Primo Analytics Widgets were not selectable in the 'Manage Widgets' function on the Alma homepage. This was fixed.

- **January 2021 Analytics SF: 00899763 00864592 00896095 00896915**
  Data Visualization projects could not be saved to a shared folder. This was fixed.

- **January 2021 Analytics SF: 00881323**
  An unexpected error occurred when the 'Holding Lifecycle' and 'Fund Information' attributes were used together. This was fixed.

- **January 2021 Analytics SF: 00894932**
  In the Titles subject area of Analytics, the field 'Material Type code' was missing under the 'Bibliographic Details' folder. This was fixed.

- **January 2021 API SF: 00895019 00856980**
  In some cases, using the update, 'User API' caused errors regarding a role's scope. This was fixed.

- **January 2021 API SF: 00887681**
  Using the REST API to create a borrowing resource sharing request with "Requested Format: Digital" and "Requested Pickup Location: Personal Delivery: Work Address" didn't work. This was fixed.

- **January 2021 API SF: 00902402**
  Updating 3M's RFID tags from within Alma wasn't possible for some tag-formats. It is now possible to configure specific
Tag Format value in the RFID Integration Profile.

- **January 2021 Fulfillment** SF: 00866057 00793104
  Auto-renewing loans for a patron record with an expiry date would send the patron a courtesy notification. The 'Notifications - Send Courtesy Notices and Handle Loan Renewals' Job Report marked these loans as 'loans not renewed' with the error message: 'The due date is already set to the renewed due date.' This has been fixed so that the Auto-Renewal job takes into consideration the current date and calculates if the library is open and if the patron's record doesn't expire before the new due date.

- **January 2021 Fulfillment** SF: 00791477 00692174
  Very poor response times when using Fulfillment. To compensate, performance improvements have been implemented for loan item actions.

- **January 2021 Fulfillment** SF: 00830987 00874018 00875133
  Performance improvements were done in the request recalculation process. This will improve the performance of circulation actions that trigger request recalculation such as loan/return/scan in, especially in cases where the scanned title has many items and many requests.

- **January 2021 Fulfillment** SF: 00862489 00885081
  Previously, when a record had a publication date but not another date field - the copyright rules calculation was incorrect. This was fixed.

- **January 2021 Fulfillment** SF: 00868459
  In a fulfillment network, if Reshelve without Transit rules were configured, the rules were sometimes incorrectly applied also in case of out-of-institution transit. As a result sometimes an error appeared when returning an item at another institution and no transit slip was printed. Now the Reshelve without Transit rules are only applied for inside institution transit and have no effect on out-of-institution transit.

- **January 2021 Fulfillment** SF: 00876402
  In a fulfillment network, when scanning an item from another institution to place it on the hold shelf, the printing of the slip failed if the item had a pop-up note or was magnetic. This was fixed.

- **January 2021 Fulfillment** SF: 00845329
  Previously, a user with the Physical Inventory Operator role with a specific scope could edit physical inventory of a different library when accessing it from the Loans tab on the Manage Patron Services when clicking the item barcode. This was fixed.

- **January 2021 Fulfillment** SF: 00900308
  Previously the Circulation DESK code field only accepted 10 characters. It is now possible to type code for circulation desks up to 20 characters.

- **January 2021 Fulfillment** SF: 00825928
  Previously, Auto-renewals job renewed loans by one day more than usual (new due date was 8 days ahead instead of 7 days) for specific timezones due to moving to Daylight Saving Time. This is now fixed.

- **January 2021 Fulfillment** SF: 00817017
  The user note at the patron workbench for items on hold shelf counter was refined to filter out booking requests which were placed on hold shelf and their end time has expired. Requests tab indicator was fixed as well to omit these requests.

- **January 2021 Fulfillment** SF: 00862302
  When printing Ful Resource Request Slip Letter in Non-English UI, the request type appears in English on the letter even though all other elements of the letter are in the correct language. The request type in the request slip letter is now translated.

- **January 2021 Fulfillment** SF: 00883360 00892041 00880576 00892299 00884671 00881902 00886461
  If the On Shelf Request policy was set to 'No requesting from available holdings', local hold requests were incorrectly canceled when a shipped item was returned from a lending request. This is now fixed.

- **January 2021 Fulfillment** SF: 00878425
  Remote Storage XML was missing locationCode for Full Chapter Digitization Requests. A new field was added in the exported XML for remote storage digitization requests. The field will now include the digitization department code.

- **January 2021 Fulfillment** SF: 00894925 00860240 00890621 00890905 00864011 00758417 00866450 00870917 00867553 00889827 00881095 00863803 00876935 00879015 00885049 00871073 00860027 0088958 00853649 00884038 00886291 00876619 00876032 00852748 00897685 00881145 00828417 00876352 00868748 00891990
  An encoding issue with the '&' character separating two parse params for portfolios caused linking not to work with portfolios that had two or more parse params. This was fixed.
• **January 2021 Fulfillment SF: 00822239**
  When the Activate/Deactivate Courses job activated a course, it automatically unsuppressed any suppressed bib records in the associated reading lists. Now the job will unsuppress the bib records of the activated courses only if the bib records are marked as course restricted. In addition, in the job's report, the list of unsuppressed records was sometimes incorrect. This was fixed.

• **January 2021 Fulfillment - Resource Sharing SF: 00870034**
  When using the Get It resource sharing form in Chrome browser, if the user tried to enter an alternative mailing address for home delivery, the fields to enter this new address did not initially appear and the user had to toggle delivery methods back and forth for the fields to appear. This was fixed. The relevant fields now appear automatically when selecting the alternative address option.

• **January 2021 Fulfillment - Resource Sharing SF: 00868303**
  The Resource Sharing Partner parameter 'Send ReturnInfo' did not update in IZ on the distribute job from the NZ. This was fixed.

• **January 2021 Fulfillment - Resource Sharing SF: 00894754**
  The locate process for the Lending Request fails if author initials are included in the request. This was fixed, the author initials will be sent in ISO protocol only when no author exists in the request.

• **January 2021 Resource Management SF: 00897326**
  The field 'Code for RFID' in Organization Unit Details stopped allowing alpha-numeric values. This was fixed.

• **January 2021 Resource Management SF: 00874647**
  Mashup uresolver: add HTML class tag surrounded the viewer service element

• **January 2021 Resource Management SF: 00890776 00890955**
  Publishing with Linked Data enrichment: Authority URIs did not appear for fields with $$u and $$e. This was fixed.

• **January 2021 Resource Management SF: 00769625**
  Clicking the 'Download EAD' button on a Top Level Collection did not work for collections with more than 1000 branches. This was fixed.

• **January 2021 Resource Management SF: 00892354**
  Thumbnail Size Validation in Collection editor was incorrect - it limited uploading thumbnail image even if it was less than 100kb. This was fixed.

• **January 2021 Resource Management SF: 00899972**
  Withdraw items job ran slowly. This was fixed.

• **January 2021 Resource Management SF: 00713586 00699791**
  When setting the display fields to view interested users in PO Line list, the field was not added to the PO Line list. This was fixed.

• **January 2021 Resource Management SF: 00865972**
  New layout > Search results > Expand drop-down > Expand All/Collapse All/All were not translated. This was fixed.

• **January 2021 Resource Management SF: 00879360**
  In brief record view, parallel fields were not displayed in Network Zone, only in Institution Zone. This was fixed.

• **January 2021 Resource Management SF: 00875552**
  In some cases, sorting of physical item search results according to call number (ascending or descending) did not work properly. This was fixed.

• **January 2021 Resource Management SF: 00885716**
  New Alma UI: Advanced search was not available for Add title search in Collection Editor. This was fixed.

• **January 2021 Resource Management SF: 00871029**
  In the related records page (repository search results --> one of the records --> 'Other details' link --> click the number near the 'Related Records' text), the blue downward arrow near the 'Record Number' field, displayed when the record has more than one record number, did not work, i.e. the rest of the record numbers were not displayed. This was fixed.

• **January 2021 Resource Management SF: 00866968 00876882 00862829 00878185 00873803**
  When creating an itemized set from Analytics and adding an Analytics report from the 'Recent reports' folder, this resulted in an error. This was fixed.

• **January 2021 Resource Management SF: 00881949**
  When calling Alma via SRU in Dublin Core, dc:contributor and dc:creator subfields $$d and $$0 are attached to the name ($$a) without any space or subfield delimiter. This was fixed. A delimiter was added between subfields.
• **January 2021 Resource Management SF: 00821160**
  When a title had both physical and electronical resources, the Digitization option appeared in GetIt even when the user was not signed in. This was fixed. Now the Digitization option appears only if the user is signed in.

• **January 2021 Resource Management SF: 00797736 00821047 00662204**
  Non filing words were not removed from prima search sort title for UNIMARC records. This was fixed. Now UNIMARC records behave like MARC21 re non-filing behavior. Note that it works according to the non-filing standard (removing the no. of ind2 of characters from the beginning of the field) and requires: 1.recalculate operational 2.Index

• **January 2021 Resource Management SF: 00890408**
  Primo VE - Year was not exported to Mendeley. This was fixed.

• **January 2021 Resource Management SF: 00885449**
  In RIS format, the TY was not always displayed first. This was fixed. New mappings of risType were added: ElectronicBooks / book, PrintBooks / book.

• **January 2021 Resource Management SF: 00904213**
  Primo VE: Getit dropdown did not reflect the Alma description. This was fixed.

• **January 2021 Resource Management SF: 00885001**
  The 'We subscribe to only some titles in this collection' configuration field disappeared on and off in the CDI tab of an electronic collection. This was fixed.

• **January 2021 Resource Management SF: 00809186**
  In UNIMARC when you created a new record using a template with a mandatory subfield, ignored it and left it blank, the expected message came up, but the saving was not blocked. This was fixed.

• **January 2021 Resource Management SF: 00843695**
  In the old Metadata Editor, it is possible to click once on one of the dropdown menus and hover over the other menus to see all the menu options. This is now possible in the New Metadata Editor.

• **January 2021 Resource Management SF: 00888317 00885498 00885438**
  Minimizing MDE after creating a new item/portfolio resulted in going back to the item/portfolio form, which could not be used. This was fixed. After minimizing, the users are taken back to the last page of Alma they visited before entering MDE.

• **January 2021 Resource Management SF: 00876915 00903652**
  New MDE: When the focus was on 'View Inventory' pane, clicking on an action did not trigger the loading popup. This was fixed.

• **January 2021 Resource Management SF: 00508216 00882017**
  A user without any Cataloger role was able to edit Holdings records. This was fixed.

• **January 2021 Resource Management SF: 00896503**
  New MDE: when using F3 > 'Headings from bib records', the first row is selected and matched.

• **January 2021 Resource Management SF: 00882599**
  New MDE: Searching in external resources after importing a record resulted in an error. This was fixed..

• **January 2021 Resource Management SF: 00881119 00882482 00888623**
  When a network member institution disconnected a linked record from the network by using the File > 'Copy to catalog' option in the Metadata Editor, the Cataloger Level from the network record was retained. This was fixed. The Cataloger Level of the disconnected record (now local) is set to the default level as defined by the member institution.

• **January 2021 Resource Management SF: 00895621 00895616 00895616 00896485 00895620 00896428**
  Search resources were not working with Aleph central catalog search. This was fixed.

• **January 2021 Resource Management SF: 00883312**
  Merge and Combined failed with an error message. This was fixed.

• **January 2021 Resource Management SF: 00899996**
  New MDE > Editing record > Search Resources > Search Cataloging Profile was displayed doubled; the edited record disappeared. This was fixed.

• **January 2021 Resource Management SF: 00895492 00883306**
  New MDE: the profiles for 'Contribute Record to Central Catalog' menu option were missing. This was fixed. A sub-menu with the database names was added to 'Contribute to Central Catalog' in case of multiple DB names in CALIS profile.
Deleted local authority record were still available in MDE using F3. This was fixed. A new data corrector was added to delete the ghost authority headings.

- **January 2021 Resource Management SF: 00848485**  
  MeSH authority records were not linked to the bib record on save or through the ‘Authorities - Link BIB Headings’ job. This was fixed. Note that re-indexing or re-saving of bibliographic records that reference MESH or Jurivoc authority headings in $$0$$ is required to correct the heading ids.

- **January 2021 Resource Management SF: 00848492**  
  When multiple name authority priorities were set (customer parameter authority_names), classification field 084 was handled as a names heading field instead of a classification heading field. This was fixed. Re-indexing or re-saving of the bibliographic records referencing RVK authorities in the 084 field is required.

- **January 2021 Resource Management SF: 00851797**  
  Authorities subject $$S$$ value was ignored upon linking field to heading, for the magnifier (see linked authority record) action. This was fixed.

- **January 2021 Resource Management SF: 00863432**  
  Authority Record View Versions list displayed the second 1XX field instead of the first. This was fixed.

- **January 2021 Resource Management SF: 00875720**  
  In cases where the same originating system id existed for both GND and IDREF authority records, the bib record was linked to a GND authority even when it was supposed to be linked to IDREF. This was fixed.

- **January 2021 Resource Management SF: 00881512**  
  During import of UNIMARC records, the fields 304, 305, 307 were not converted to MARC21 500 fields. This was fixed.

- **January 2021 Resource Management SF: 00865355**  
  In MD Import, the sorting of the 'Submitted On' column was wrong. This was fixed.